Kanban Features

Use the highly flexible Kanban facility in Sparx Systems Enterprise Architect for dynamic, easy-to-view project management of, for example, strategic planning or software-centric solutions, under methodologies such as Agile, Iterative and Incremental.
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kanban Features</td>
<td>3</td>
</tr>
<tr>
<td>MDG Technology for Kanban</td>
<td>10</td>
</tr>
<tr>
<td>Kanban Tasks</td>
<td>12</td>
</tr>
<tr>
<td>Kanban Diagram Options</td>
<td>18</td>
</tr>
<tr>
<td>- Sub-Lanes</td>
<td>22</td>
</tr>
<tr>
<td>- Appearance</td>
<td>24</td>
</tr>
<tr>
<td>- Advanced</td>
<td>28</td>
</tr>
<tr>
<td>- Filters</td>
<td>30</td>
</tr>
<tr>
<td>Default Kanban Diagrams</td>
<td>32</td>
</tr>
<tr>
<td>Allocating Resources to Work Items</td>
<td>34</td>
</tr>
<tr>
<td>Related Model Elements</td>
<td>41</td>
</tr>
<tr>
<td>Managing a Backlog</td>
<td>43</td>
</tr>
<tr>
<td>Elaboration and Grooming</td>
<td>48</td>
</tr>
<tr>
<td>Alternate Views</td>
<td>50</td>
</tr>
<tr>
<td>Other Processes and Methods</td>
<td>54</td>
</tr>
</tbody>
</table>
Kanban Features

Background

Kanban, which literally translates as Visual (Kan) Card (Ban) or billboard, is an operational method used to increase efficiency. It was originally developed by the industrial engineer Taiichi Ohno while working at Toyota. Ohno analyzed the way supermarket shelves are stocked and applied the lessons learnt to the factory floor, creating unprecedented efficiency. The visual card (Kanban) was used to signal the need for more items to upstream suppliers on the production line. The Kanban method can be applied to any field, including strategic planning, sales and marketing, and human skills management, but more recently Kanban has been applied to the process of developing software-centric solutions in an attempt to ensure that value is delivered to the customer as quickly as possible. The information technology industry has been plagued since its beginning with projects running over schedule and over budget, but more significantly failing to deliver value to customers in a time frame that enables them to compete and be successful. These endemic issues have become a critical element of business in an age dominated by digital disruption and unprecedented change.

Principles

Kanban is fundamentally very simple and relies on a small number of principles, the origins of which can be attributed to the engineers at Toyota:

- **Make work visible**
  Traditional project management methods hide the work items from the people who carry out the work; Kanban exposes the work to everyone, allowing any team member to contribute to the way work items flow through the board and ultimately deliver value to the customer.

- **Limit work in progress**
  Project managers and team leads have traditionally been under pressure to get products finished or to include more features, and have responded to this pressure by burdening the team with more work items; this results in lots of focus switching and inevitably half-finished items and reduced efficiency. Paradoxically, Kanban encourages the number of items in progress to be limited, resulting in greater efficiency and more finished items; the reduced number of in-progress items allows team members to concentrate on one thing at a time without having to switch focus.
Manage the flow of work

Using traditional project management methods, bottlenecks or blockers are hard to identify and typically only surface at the time of a post project review, often only after the product is delivered late and missing features. Using Kanban, the visibility of work and the ability to identify stalled processes - whether because of bottlenecks or lack of work items - allows a flow problem to be identified and rectified quickly.

The next diagram shows the way the Kanban facility in Enterprise Architect responds when the number of items in a lane exceeds the number specified in the max items (Work in Progress or WIP limit) value for that lane; the header is highlighted in a configurable color and the numbers (number of items/max items) also provide a visual cue that will prompt the team to respond by swarming (a number of team members focusing) on the lane to reduce the number of items.

Example

A high priority User Story that is at the top of the backlog could be pulled into the 'In Progress' lane and a developer could immediately commence work on it. The work might entail the coding of business rules, the review of detailed requirements, changes to a database schema or the addition of an element or attribute to an information schema, and the creation of a new or updated deployment environment.
All of these artifacts can be found inside the same repository without the need to launch other tools or schedule meetings to locate the needed information. The strategic drivers can be seen in the context of their business owners, architectural design and principles can be viewed, Business Rules can be visualized in relation to the policies they qualify, a live connection can be made to the databases and their schemas analyzed and altered, XML schemas can be inspected and messages constructed, programming code can be written and deployment targets detailed, and all of this achieved in a single collaborative platform.
Example

This diagram demonstrates a Backlog diagram in a two or three stage workflow. The entire diagram is used to manage the backlog and items can be dragged within a lane to define their order in that lane, or between lanes to define their importance and position in the backlog.

Flexibility

Enterprise Architect has a flexible and integrated Kanban facility built into the core product, allowing projects of any size and vertical market to benefit from the profound efficiencies that come with this simple, elegant and lean project management approach. Regardless of the type of process that is being used, Enterprise Architect’s Kanban features can be quickly and seamlessly integrated into any method, creating a compelling visual solution and team collaboration platform that will result in products, services and solutions being delivered to customers with efficiency and in record time - delighting both product owners and customers alike.

The Kanban features in Enterprise Architect are highly configurable and can be altered to suit any team and process, including Agile, iterative and incremental, and even waterfall projects. There is a very low barrier to adoption and teams can commence with Kanban immediately. The most basic Kanban board consists of a diagram divided into a small number of lanes; a range of work items can be added to the diagram, including Features, User Stories, Defects, Changes, Use Cases, Requirements and more. Work Items can be drawn with a compelling visual style representing a colored card, and can be dragged anywhere in the diagram to change order in a given lane, or from lane to lane progressing from left to right through the board, representing progress towards value for the customer. The lanes are typically bound to the values of a 'project management aware' property such as status or phase, and as the item is dragged from lane to lane the value of the bound property is automatically changed.

Resource Allocation

Any number of resources, performing specified roles, can be allocated to work items as they flow through the Kanban board, and the progress can be visualized as one or more progress bars displayed at the bottom of the card. The allocation is driven by Enterprise Architect's practical and simple resource allocation facility, which can be used to define the relationship between resources (team members) and work items (cards). Any number of team members can assign themselves to a work item, indicating the role they will perform, and the start date, finish date, and the expected time can be used to record estimates of how long the task will take.
Progress can be updated as a percentage of completion, which can be displayed visually on the card. The Kanban board (like any diagram) can also be displayed as a Gantt chart or a list view, supporting alternative project management representations.

Configuration

The Kanban cards can be configured to display an extensive set of properties, with compelling icons, colors and progress bars to communicate the important aspects of the work item, resource allocation and work item progress. The properties include the item name, type, status, version, priority, stereotype, phase, author and more.
The names, colors and number of lanes can be configured, in addition to a range of other properties such as the overfill limits, defaults and the definition of sub-lanes. The appearance of the board and the work items can all be configured, using different colors, fonts and styles including a hand-drawn mode that might appeal to teams more accustomed to using a physical board with colored notes. It is also possible to set the chart appearance to highlight elements that come from the same hierarchies.

Enterprise Architect has built-in Kanban diagrams, and a number of workflow Patterns that are pre-built and that can be used 'As-Is' or configured to suit any project or initiative. The workflow Patterns define one, two or three stage workflows; for example, the two stage workflow defines a Kanban board solely for managing the prioritization of the backlog, and items from the backlog are then moved from the backlog Kanban to the first lane of the iteration Kanban. If necessary, the Product Owner can use Enterprise Architect's security facility to lock the backlog Kanban, ensuring that the order of items in the backlog is not inadvertently changed.

There are a number of commercial tools that allow Kanban to be used to manage projects visually, but Enterprise Architect's Kanban facility is incredibly powerful because the tool is also a sophisticated modeling platform for strategic and business analysis, architecture, design, implementation, testing and deployment. This means that work items on a Kanban Board can be linked to strategic decisions, business rules, policies, requirements, architecture and design elements, wireframes and UX models, programming code, database tables, procedures, tests, virtual or physical deployment nodes, and more. For the first time everyone in the team can collaborate in the same environment using a toolbox of facilities purpose built for their discipline, while at the same time being able to visualize and manage the value being delivered to the customer in a powerful and visually compelling set of Kanban boards.

Charts and Dashboards

Enterprise Architect has a sophisticated charting facility that can be used to create powerful and expressive charts and dashboards that will provide insights into the Kanban process and enable Product Owners and other team members to monitor performance and determine ways of fine tuning how the team is working. There is a range of built-in charts including bar and pie charts, heat maps and more but a team is free to create any number of user-defined charts and these can be incorporated into team processes and reviews.
Application

The Kanban project management methodology helps you to develop a dynamic, easy-to-view progress summary of the stages of development of a project, where the stages are represented as lanes and sub lanes of a diagram - a Kanban Board. In Enterprise Architect, you can apply a form of this methodology to your project administration diagrams to monitor and manage the flow of work in a particular area.

The stages of development can be defined by the value of a project management property of an element, such as Phase, Version or Status, or a user-defined Tagged Value. The elements that represent each task or object of a task are initially placed in the lanes for the earlier stages of the project, and work on the task is reflected by moving the corresponding element to a different lane on the diagram. If a diagram is linked to a project management property, dragging an element from one lane to another automatically changes the value of the property to the value that the lane represents.

In this illustration, the lanes identify what work is being performed in each stage of development.

New tasks will usually begin in the left-most lane, and completed tasks will usually pass through all lanes before coming to rest in the right-most lane and then being moved off the diagram. A typical workflow is to choose the next task that you are going to work on by starting in the right-most lane and seeing if it has any tasks that you are able to progress; if not, move to the next lane and repeat, and so on.
MDG Technology for Kanban

The MDG Technology for Kanban Diagrams provides diagram types and patterns that underpin the creation of Kanban diagrams. Whilst it is possible to create Kanban diagrams from most UML diagram types and design the workflows on them from scratch, these diagram types and patterns help you to generate a Kanban that matches your requirements and then adjust the settings to suit, thus saving time and effort.

Access

On the 'MDG Technologies' dialog, in the 'Technology' panel, select 'Kanban' then click on the 'Enabled' checkbox and on the OK button.

| Ribbon                     | Specialize > Technologies > Manage |

Kanban Diagram Types

The MDG Technology for Kanban Diagrams provides four kinds of pre-defined Kanban diagram, as described here. To create one of these diagrams, open the 'New Diagram' dialog, use the 'Select From' header to select the 'Software Construction > Kanban Perspective' in the left-hand pane and choose one of the diagram types from the right-hand pane.

<table>
<thead>
<tr>
<th>Diagram Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic</td>
<td>The Basic Kanban diagram contains these lanes:</td>
</tr>
<tr>
<td></td>
<td>• Backlog</td>
</tr>
<tr>
<td></td>
<td>• Queue</td>
</tr>
<tr>
<td></td>
<td>• In Progress</td>
</tr>
<tr>
<td></td>
<td>• Done</td>
</tr>
<tr>
<td></td>
<td>The Basic Kanban diagram doesn't have a lane binding to any element property.</td>
</tr>
<tr>
<td>Backlog</td>
<td>The Backlog Kanban diagram contains these lanes:</td>
</tr>
<tr>
<td></td>
<td>• Low</td>
</tr>
<tr>
<td></td>
<td>• Medium</td>
</tr>
<tr>
<td></td>
<td>• High</td>
</tr>
<tr>
<td></td>
<td>• Critical</td>
</tr>
<tr>
<td></td>
<td>The lanes are bound to the element Priority, so that moving elements between lanes will automatically update their Priority to the name of the lane.</td>
</tr>
<tr>
<td>Iteration</td>
<td>The Iteration Kanban diagram contains these lanes:</td>
</tr>
<tr>
<td></td>
<td>• Queue</td>
</tr>
<tr>
<td></td>
<td>• In Progress</td>
</tr>
<tr>
<td></td>
<td>• Test/Review</td>
</tr>
<tr>
<td></td>
<td>• Done</td>
</tr>
<tr>
<td></td>
<td>The lanes are bound to the element Phase, so that moving elements between lanes will automatically update their Phase to the name of the lane.</td>
</tr>
<tr>
<td>Complete</td>
<td>The Complete Kanban diagram contains these lanes:</td>
</tr>
</tbody>
</table>
Kanban Features

Kanban Features

16 January, 2019

• Ready for Release
• Staging
• Production
• Done

The lanes are bound to the element Phase, so that moving elements between lanes will automatically update their Phase to the name of the lane.

Kanban Workflow Patterns

Kanban Workflow model Patterns help you to very quickly set up a one, two or three stage workflow, using and linking the Backlog, Iteration and Complete Kanban diagrams.

<table>
<thead>
<tr>
<th>Workflow Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-stage Workflow Pattern</td>
<td>The 1-stage Workflow Pattern consists of a single Kanban diagram with the Backlog, Queue, In Progress, Test/Review, Done, and Deploy lanes. These lanes are linked to the Phase property of elements, so that moving elements between lanes will automatically update their Phase to the name of the lane.</td>
</tr>
</tbody>
</table>
| 2-stage Workflow Pattern | The 2-stage Workflow Pattern consists of two related Kanban diagrams:
• A Backlog Kanban diagram with Low, Medium, High and Critical lanes linked to the Priority property of elements, so that moving elements between lanes will automatically update the Priority to the name of the lane, and
• An Iteration Kanban diagram with Queue, In Progress, Test/Review, Done and Deploy lanes linked to the Phase property of elements, so that moving elements between lanes will automatically update their Phase to the name of the lane

Each diagram also has a drop zone that helps you to move elements easily between diagrams. Simply drag the elements onto the appropriate zone (having the name of the diagram to move elements to) and select either 'Move to' to move the element to the new diagram, or 'Create link on diagram' to create a link on the second diagram without removing it from the current diagram. |
| 3-stage Workflow Pattern | The 3-stage Workflow Pattern consists of three related Kanban diagrams:
• A Backlog Kanban diagram with Low, Medium, High and Critical lanes linked to the Priority property of elements, so that moving elements between lanes will automatically update the Priority to the name of the lane
• An Iteration Kanban diagram with Queue, In Progress, Test/Review, and Done lanes linked to the Phase property of elements, so that moving elements between lanes will automatically update their Phase to the name of the lane, and
• A Complete Kanban diagram with Ready for Release, Staging and Production lanes linked to the Phase property of elements, so that moving elements between lanes will automatically update their Phase to the name of the lane

Each diagram also has a drop zone that helps you to move elements easily between diagrams. Simply drag the elements onto the appropriate zone (having the name of the diagram to move elements to) and select either 'Move to' to move the element to the new diagram, or 'Create link on diagram' to create a link on the second diagram without removing it from the current diagram.
Kanban Tasks

Create a Kanban Diagram

A Kanban diagram is a board that allows team members to visualize work items that are represented as colored cards. The board is divided into a number of lanes and team members move the cards from left to right as work is completed towards providing value to the customer.

You can create a Kanban diagram by taking an existing diagram and setting its Kanban properties, but it is easier to use one of the diagram types provided by the MDG Technology for Kanban Diagrams as a starting point and then change its properties to suit your own project.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the Project Browser, right-click on the parent Package and select the 'Add Diagram' command.</td>
</tr>
<tr>
<td>2</td>
<td>In the 'New Diagram' dialog, use the 'Select From' header to select the 'Software Construction &gt; Kanban Perspective' in the left-hand pane and choose one of the diagram types from the right-hand pane (Basic, Backlog, Iteration and Complete). Give the new diagram a name in the 'Diagram' field and click on the OK button.</td>
</tr>
<tr>
<td>3</td>
<td>If you cannot find 'Kanban' in the list, you must enable the Kanban MDG Technology.</td>
</tr>
</tbody>
</table>

Add Elements to a Kanban Diagram

Work items are represented visually on a Kanban diagram but first must be added to the diagram. They can be elements
that already exist in the repository or new elements dragged from the Kanban toolbox and dropped onto the diagram. Any element type can appear on a Kanban board but the most typical types are Features, User Stories, Defects and Changes, Use Cases, Scenarios and Requirements are also sometimes added.

When you drop an element onto a Kanban diagram, the lane it is added to depends on whether the diagram has a property value defined, and also whether it has a default lane. If the Kanban diagram has a property value defined and the new element's property matches one of the lanes, then it will be added to that lane. Otherwise, it will be moved into the default lane, or to the right of the last lane if no default lane has been nominated.

You can define the Default lane on the 'Lanes' page of the 'Kanban Options' dialog.

The Kanban Toolbox page will open automatically whenever you open a diagram created from the MDG Technology for Kanban Diagrams. The Toolbox page provides a default set of elements that you can use to represent units of work on your Kanban diagrams, but any type of element can be added.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | Open your Kanban diagram. The Diagram Toolbox should appear with the Kanban page selected automatically.  
• If the Diagram Toolbox doesn't appear, click on the >> button in the top left corner of your diagram  
• If the Kanban page isn't automatically selected, click on to display the 'Find Toolbox Item' dialog and specify 'Kanban' |
| 2    | Drag elements from the Kanban page onto the Kanban diagram. The page provides these element types:  ![Toolbox](image) |

Import a Kanban Workflow Pattern

Each organization or team will typically want to define their own workflow that is appropriate for the initiatives they work on, and each might have a number of workflows defined for different types of initiative. While this can be done from scratch it is much easier to use one of the built-in Patterns, either 'As-Is' or as a starting point. A workflow can be made up of any number of Kanban boards linked together into a single workflow; for example, a three stage workflow would contain three separate boards. Each board can be configured with any number of lanes and sub-lanes representing the stages in that part of the workflow. Team members can move Work Items between lanes in a single board and also between the boards that make up the entire workflow.

Kanban Workflow model Patterns help you to very quickly set up a one-, two- or three-stage workflow, using and linking the Backlog, Iteration and Complete Kanban diagrams.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the Project Browser, select the Package under which to create the Workflow Pattern.</td>
</tr>
<tr>
<td>2</td>
<td>Click on the Project Browser header and select the 'New Model from Pattern' option, or press Ctrl+Shift+M. The Model Wizard window displays.</td>
</tr>
</tbody>
</table>
Select the 'Model Patterns' tab, then click on the Perspective drop-down arrow and select 'Project Management > Kanban'. The panel header changes to 'Kanban Perspective' and the panel shows the three workflow patterns you can select.

- Kanban One Stage Workflow
- Kanban Two Stage Workflow
- Kanban Three Stage Workflow

When you click on one of the patterns, the right hand panel displays an example diagram and several sections of useful information on using the pattern.

If you have the 'Customize Pattern on import' checkbox selected, prompts display to select the Packages to import in the Patterns. Each Pattern contains one Package, which is automatically selected. Click on the OK button for each Pattern.

Open each of the new diagrams and consider whether they fit with your own workflow preferences. The diagrams provided can be changed to suit your style of working.

Moving Kanban Items

Work Items flow through Kanban boards typically from left to right as work is performed, moving the item closer to delivering business value for the customer. In a one-stage workflow, work items will be moved through a series of lanes through a single board, but in workflows that consist of more than one Kanban board the items will also jump from one board to the next. For example, in a two stage workflow there is a backlog board and items will be prioritized in the board based on their priority. The work items that have the highest priority in the Backlog then need to be moved to the Iteration Board, where implementers will pull them into the In-Progress lanes.

Moving Items in a Kanban Diagram

Moving items within a Kanban diagram is simple and intuitive and can be achieved by dragging and dropping a work
item from one location to another. If an item is moved within the same lane its position is simply changed in that lane. If an item is dragged to a different lane and the lanes are bound to an element property or user defined Tagged Value the value of the item's property or tag will also be changed.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select the item in the Kanban diagram.</td>
</tr>
<tr>
<td>2</td>
<td>Drag and drop it into a new position either in the same lane or a different lane.</td>
</tr>
</tbody>
</table>

Notes

When an item is moved between lanes and the lanes are bound to a property or Tagged Value, the value of the property or Tag will be automatically changed.

Example

Moving Items between Kanban Diagrams

Items can be moved between Kanban boards by using a drop zone positioned to the right of the diagram. Each drop zone has the name of another diagram in the workflow, and elements on the current board can simply be moved by dragging and dropping them on the appropriate drop zone.

To create a drop zone, simply drag the target Kanban board onto the current Kanban diagram and release the mouse button. In response to the prompt, select the 'Drop Diagram as Diagram Reference' option. You can have more than one drop zone, one for each of the other Kanban boards in the workflow. If you generate a set of Kanban workflow diagrams using the Patterns in the Model Wizard, the drop zones are automatically generated on each diagram.
## Kanban Features

### Step 1
Select the item in the Kanban diagram.

### Step 2
Drag the item to the right of the Kanban diagram Lanes.

### Step 3
Drop the item onto the zone with the name of the diagram you are moving the element(s) to.

### Step 4
Select 'Move to' to move the element to the new diagram or 'Create link on diagram' to create a link on the second diagram without removing the element from the current diagram.

### Example

In this diagram a work item representing a defect is being moved from the critical lane of a Backlog Kanban board to the Iteration board.

### Search for Kanban Diagrams

A well organized repository will assist in quickly locating specific Kanban diagrams, but in large and complex initiatives it is common for some team members to need to search for Kanban Boards. Enterprise Architect has an easy-to-use yet sophisticated search facility with a built-in search to find all Kanban diagrams in the repository. Having located a diagram the user can continue moving objects from left to right across the board, contributing to the team’s effort focused on providing value to the customer.

### Step 1
Select the ‘Construct > Task Management > Kanban > Find Kanban Diagram’ ribbon option. The search is immediately executed and the located diagrams are listed in the Find in Project view.

### Step 2
Double-click on any Kanban diagram that you want to open.

### Layout Filter Panel

(c) Sparx Systems 2018  Page 16 of 56  Created with Enterprise Architect
A project of any appreciable size will typically have a large number of in-flight work items, and product owners and team members will often want to filter the selection of items based on a set of conditions, such as high priority requirements or those applying to particular stakeholders or people. This can be achieved using filters at two levels; either the expedient ribbon Filter or the more sophisticated and persistent Diagram Filters facility.

Kanban diagrams with a large number of elements can be quickly filtered in real time using the Layout ribbon Filter panel.

1. Access the Filter panel.
2. Select the Filter property and the operator (if appropriate), and specify a search term.

Elements not matching the specified condition will be obscured in the filtered diagram.

<table>
<thead>
<tr>
<th>Backlog</th>
<th>Queue</th>
<th>In Progress (3/6)</th>
<th>Test/Review</th>
</tr>
</thead>
<tbody>
<tr>
<td>As an Administrator I want to be able to have a maintenance window to update online web pages and content</td>
<td>As a Customer I want to be able to add new orders to existing ones if they have not shipped</td>
<td>As A Student I want to buy books at Academic Prices</td>
<td>As a Warehouse Manager I want to be able to determine the best product location to minimize picking errors</td>
</tr>
<tr>
<td>As a Customer I want to be able to delete items from my order before it is shipped</td>
<td>(Defect)</td>
<td>As a Reviewer I want to be able to add and edit rules in the online grammar checker</td>
<td>(Test)</td>
</tr>
<tr>
<td>UserStory</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>As a Stock Manager I want to be able to predict product demand</td>
<td>As a Customer I want to be able to view the status of my order</td>
<td>As a Sale Representative I want to be able to view historical leads</td>
<td>(Test)</td>
</tr>
<tr>
<td></td>
<td>UserStory</td>
<td></td>
<td></td>
</tr>
<tr>
<td>As a Reviewer I want to be able to be able to add words to the online dictionary</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Kanban Diagram Options

Enterprise Architect provides a number of options for generating a new Kanban diagram or for opening an existing Kanban diagram. Having opened the diagram, you can define its structure, content and appearance. It is also possible to configure a diagram of any other type to be a Kanban diagram, by simply adding Kanban properties to it. This powerful design feature means that a diagram containing, for example, a set of User Stories could simply be changed to a Kanban diagram and the team could immediately begin using this flexible, lean, project management method.

To define the structure, content and appearance of a Kanban diagram, you use the 'Kanban' dialog.

When you display the 'Kanban' dialog, it defaults to the 'Configuration' page. You use this page to:

- Set up basic Kanban properties, such as whether Kanban is enabled on the diagram, if the names are shown in the title bar of the diagram and if the width of each swimlane is locked, and
- Create, modify and delete the primary lanes on a Kanban diagram; you can:
  - Create the lanes manually, or define a property that the lanes bind to, so that the lanes are generated automatically from that property when you click on the Fill from binding button
  - Add lanes that are not bound to the property

For each lane you can define:
- The maximum number of elements that can be placed in the lane before triggering the 'Overfilled' indicator
- The fill color of the lane
- Whether it is the default lane that new elements are added to

Access

| Ribbon | Construct > Task Management > Kanban > (options to generate and/or open a |
### Kanban Features

Kanban diagram) or
Start > Collaborate > My Kanban (displays personal default Kanban diagram)
Then
Design > Diagram > Edit > Kanban (on an open Kanban diagram)

### Context Menu

On a Kanban diagram, double-click on a lane
On any other type of diagram, right-click on background | Kanban

### Configuration Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>Select the checkbox to apply any of the Kanban functionality to the diagram. If the checkbox is not selected, the diagram will behave as a non-Kanban diagram.</td>
</tr>
<tr>
<td>Show Names in Title Bar</td>
<td>Select this checkbox to display the lane names (but not the sub-lane names) in the diagram title bar, above the lanes. These will be visible once the lanes are defined.</td>
</tr>
<tr>
<td>Swimlane width locked</td>
<td>Select this checkbox to prevent the lanes in the diagram from being made narrower or wider.</td>
</tr>
</tbody>
</table>
| Bind Kanban to          | Click on the button and select the property to bind lanes to. This will be one of:
  - Element, or
  - Tagged Value (enumeration or string types only), or
  - None (makes all lanes unbound).
  If you select 'Element', also select one of the properties 'Phase', 'Version', 'Priority' (for Requirement-type elements), 'Status' or 'Author'.
  If you select 'Tagged Value', also choose to either 'Create' a new tag (and simply type in the name) or 'Select' an existing one.
  In the latter case, the 'Kanban Tagged Value selection' dialog displays, on which you click on the appropriate radio button to select either from a list of 'Global Tagged Values', or from a list of 'Tagged Values from a selected element'. Click on the Select Element button to browse for the element anywhere in the model.
  The Global Tagged Values or those from the element are provided to the 'Tagged Value' field. Click on the drop-down arrow on the right of the field and select the reference Tagged Value from those listed. Click on the OK button.
  The 'Bind Kanban to' field now displays either the element property or the Tagged Value you have selected. |
| Fill from binding       | If you have chosen an element property to bind the Kanban lanes to, click on the Fill from binding button to fill the lane list with existing values of that property. This will delete all old lanes before creating a new lane for each of the new values. Once the lanes have been created in this way, they can be renamed, reordered and added to. |
| Name                    | The name of each lane can be filled automatically using the Fill from binding button. You can overtype the names; these do not have to be unique but they cannot |
Max Items
You can set the maximum number of elements that can be placed in each lane. If someone tries to move an element into a lane that has reached or exceeded its maximum number, the heading of the lane will be displayed in the 'Overfilled' color you define and enable on the 'Appearance' page. This gives a visual indication that action might have to be taken to clear what appears to be a bottleneck in the workflow process.

Color
Several or all of the lanes can have the same fill color, or you can set a different color for each lane independent of the other lanes. Either:
- Leave the 'Color' value set to 'Default' (set on the 'Preferences' dialog, 'Gradients and Background' page), or
- Overtype 'Default' with the hex code number for the required color, or
- Click on the drop-down arrow and select a color from the displayed palette.

The actual color is shown in the box at the left of the field.

Default
You can nominate one of your lanes as the default; that is, the lane to which new elements are added if they don't match the binding property. For example, if a Kanban diagram is bound to 'Priority' and has the lanes 'Low', 'Medium' and 'High', with 'Low' as the default, when an element with a Priority of 'Undetermined' is added, it will be placed into the default 'Low' lane. You can only select one 'Default' checkbox; clicking on a checkbox clears any previously-selected checkbox.

Unbound
The Unbound property essentially makes a primary lane the same as a sub-lane. Moving an element into an unbound lane will set the element's bound property to the left most bound lane. Consider a 'Phase' Kanban diagram with these lanes, in order:
- To Do (Default, Unbound)
- Implement (Bound)
- To Do (Unbound)
- Review (Bound)
- To Do (Unbound)
- Deploy (Bound)

Newly added elements will be added to the left-most 'To Do' lane with whatever priority value they previously had. Moving them to the 'Implement' lane will then set the phase to 'Implement'. When the implementation is complete, the element can be moved to the 'To Do' lane before 'Review' without updating the element's phase until it is moved into the 'Review' lane.

New
Click on this button to define a new lane on the Kanban diagram.

Modify
Click on a line in the 'Lanes' list and click on this button to position the cursor in the 'Name' field in update mode, and to highlight the lane you are modifying to make it easier to focus on the fields you might change.

Delete
Click on a line in the 'Lanes' list and click on this button to delete the lane.

Click on an entry in the 'Lanes' list and click on this button to move the entry one line up in the list, and one lane to the left on the diagram.

Click on an entry in the 'Lanes' list and click on this button to move the entry one line down in the list, and one lane to the right on the diagram.
Notes

- The elements in a Kanban diagram individually represent work in progress; you cannot create connectors between elements on the diagram.
- If you apply a Kanban definition to a current diagram, all connectors on the diagram are hidden; when you de-activate the definition, the connectors are shown again.
- When you first set up a Kanban diagram, any element on the diagram that does not have one of the defined property values is moved to the right-hand side of the diagram.
- Moving an element into a lane automatically sets the appropriate property of that element to the value represented by the lane; for a Tagged Value, if the element does not have that tag, adding the element to the lane adds the tag and sets it to the lane value.
- Elements on a Kanban diagram are automatically adjusted to match the width of the lane they are in, both when the element is moved into a lane and when the lane width is changed.
- Certain types of element are automatically excluded from a Kanban diagram search; these are:
  - Constraint
  - Port
  - ProvidedInterface
  - RequiredInterface
  - Boundary
  - Hyperlink
  - State Node (such as Choice and Junction)
  - Text
  - Win32
  - Wireframing
  - Package
  - Diagram Frame
  - Activity Region
  - Sequence Element
  - Note
  - Standard Chart
  - Model View
  - Time Series Chart
Kanban Diagram Options - Sub-Lanes

Sub-lanes are a useful device for defining another level in the workflow; for example, you might want to divide the 'In-Progress' lane into a number of sub-lanes representing the individual developers, or any lane into 'In-Progress' and 'Complete'. The 'Sub-lanes' page helps you to quickly and easily create any number of new sub-lanes for a Kanban diagram.

Access

<table>
<thead>
<tr>
<th>Ribbon</th>
<th>Construct &gt; Task Management &gt; Kanban &gt; (options to generate and/or open a Kanban diagram) or Start &gt; Collaborate &gt; My Kanban (displays personal default Kanban diagram) Then Design &gt; Diagram &gt; Edit &gt; Kanban &gt; Sub-lanes (on an open Kanban diagram)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Context Menu</td>
<td>On a Kanban diagram, double-click on a lane &gt; Sub-lanes On any other type of diagram, right-click on background</td>
</tr>
</tbody>
</table>

Creating Sub-Lanes

You add sub-lanes simply by clicking on the New button and, in the 'Name' column, typing the sub-lane name.
Alternatively, you can leave the default string '<anonymous>' to create an un-named sub-lane, which can be useful for organizing lanes that have lots of elements. The names of the lanes on the diagram are then automatically added across the panel.

Once you have created sub-lanes, you apply each one to one or more parent lanes, by selecting the checkbox under the name of each lane that is to contain the sub-lane. To assign every sub-lane to every lane, you can click on the Check all button, and to clear this total assignment click on the Uncheck all button. You can also change the order of the sub-lanes across all their parent lanes in the Kanban diagram, by clicking on the sub-lane names and on the up-hand and down-hand buttons.

Within a specific parent lane column you can apply custom sorting to the sub-lanes, so that the sub-lanes in that lane are in a different sequence to the same sub-lanes in a different lane. For a column that has assigned sub-lanes (that is, it contains selected checkboxes) right-click on the header and select the 'Set lane order' option. A small dialog displays, in which you click on the sub-lane names and use the up-hand and down-hand buttons to put them in the required sequence. Click on the OK button to clear the dialog and apply the sub-lane. If a sub-lane order has been customized, you can return it to the 'across-the-board' order by right-clicking the header again and selecting the 'Reset lane order' option.

Notes

- Sub-lanes are not backwards compatible with earlier releases of Enterprise Architect; if you open a Kanban diagram containing sub-lanes in a release of the system earlier than Release 12.1, the sub-lanes will be permanently deleted from the diagram.
- Elements on a Kanban diagram are automatically adjusted to match the width of the sub-lane they are in, both when the element is moved into a sub-lane and when the sub-lane width is changed.
Kanban Diagram Options - Appearance

Using the 'Appearance' page, you can set the Kanban diagram appearance options, such as the line and font colors and use of the Hand Drawn mode.

Objects on a Kanban diagram are, by default, drawn using the **Info View style**.

This style displays an icon on the top right corner of the element, representing the element type, with a triangular icon to the left of it representing the priority - red for High priority, and yellow for Medium priority. No icon shows for Low priority. The Priority, as for various other element properties, is also represented by a line of text in the body of the element. You can specify which properties are shown by selecting the appropriate checkbox from the list at the bottom of the 'Appearance' page.

**Appearance Options**
<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Color</td>
<td>Click on the drop-down arrow and select the color in which to display lane borders. This color does not apply to sub lane borders, which are automatically set to a pale or dark color to contrast with the lane fill color. If the color you require is not shown, click on the More colors button and either select from a wider range of standard colors or define a custom color. The border style is automatically set to the 'chiseled' effect to give the appearance of 3D blocks on a background, the color of the background being the line color. The effect is more obvious if you set the line to a pale color and not black.</td>
</tr>
<tr>
<td>Font Color</td>
<td>Click on the drop-down arrow and select the color in which to display the text in the Kanban lane and sub lane headings. If the color you require is not shown, click on the More Colors button and either select from a wider range of standard colors or define a custom color.</td>
</tr>
<tr>
<td>A</td>
<td>Click on this button to display the 'Font' dialog, through which you define the font and the style, size and effects of the text in the Kanban lane and sub lane headings. If you also change the text color here, it overrides the setting of the 'Font Color' field.</td>
</tr>
<tr>
<td>Title Color</td>
<td>Click on the drop-down arrow and select the color to use across the lane heading cells (separate from the fill colors you can apply individually to each of the lanes themselves). If the color you require is not shown, click on the More Colors button and either select from a wider range of standard colors or define a custom color.</td>
</tr>
<tr>
<td>Overfilled Color</td>
<td>Click on the drop-down arrow and select the color with which to fill a lane heading cell if the lane contains more than the maximum number of elements. You set the maximum number of elements when you define the lanes to work with, in the 'Lanes' page. If the color you require is not shown, click on the More colors button and either select from a wider range of standard colors or define a custom color.</td>
</tr>
<tr>
<td>Underfill Color</td>
<td>Click on the drop-down arrow and select the color with which to fill a lane heading cell if the column contains fewer than the maximum number of elements, in other words there is available capacity. You set the maximum number of elements when you define the lanes to work with, in the 'Lanes' page. If the color you require is not shown, click on the More colors button and either select from a wider range of standard colors or define a custom color.</td>
</tr>
<tr>
<td>Line Width</td>
<td>Click on the drop-down arrow and select the line width of the Kanban lane borders - either 1 (thinnest), 2 or 3 (thickest).</td>
</tr>
<tr>
<td>Vertical Spacing</td>
<td>Set this to 'Small', 'Medium' or 'Large' to define the degree of vertical separation between elements in a Kanban lane.</td>
</tr>
<tr>
<td>Hide Names</td>
<td>Select this checkbox to hide the lane names and the column heading cells.</td>
</tr>
<tr>
<td>Bold Font</td>
<td>Select this checkbox to display the lane headings in bold (if their font definition does not already set them to bold).</td>
</tr>
<tr>
<td>Hand Drawn</td>
<td>Select this checkbox to display the Kanban lanes and the elements on the diagram.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable Overfill Highlight</td>
<td>Select this checkbox to apply the 'overfilled' color to the lane header cell if it contains more elements than the defined maximum number (see New).</td>
</tr>
<tr>
<td>Enable Underfill Highlight</td>
<td>Select this checkbox to apply the 'underfilled' color to the lane header cell if the lane contains fewer elements than the defined maximum number; that is, if it has any spare capacity.</td>
</tr>
<tr>
<td>Highlight Hierarchies</td>
<td>Select this checkbox to highlight elements on the Kanban diagram that are part of the same hierarchy, by drawing a colored rectangle behind each element. If there are elements from two or more hierarchies on the same diagram, each hierarchy is represented by background rectangles of a different color to the others. In this illustration, Class 1 and Class 2 are both in one hierarchy, and Class 5 and Class 6 are both in a second hierarchy.</td>
</tr>
</tbody>
</table>

**Approved**
- Class 6
  - Approved

**Implemented**
- Class 1
  - Implemented
- Class 2
  - Approved
- Class 5
  - Implemented

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Kanban drawing style</td>
<td>Select this option if you want to apply the Kanban style to the elements on this Kanban diagram. Also, select the checkbox against each element property or characteristic to be shown in the elements:</td>
</tr>
<tr>
<td></td>
<td>- Type - displays the element type</td>
</tr>
<tr>
<td></td>
<td>- Status - displays the element status</td>
</tr>
<tr>
<td></td>
<td>- Version - displays the element version</td>
</tr>
<tr>
<td></td>
<td>- Priority - displays the element priority</td>
</tr>
<tr>
<td></td>
<td>- Bold name - displays the element name in bold</td>
</tr>
<tr>
<td></td>
<td>- Notes - displays element notes in the elements on the Kanban diagram</td>
</tr>
<tr>
<td></td>
<td>- Capitalize Name - displays element names in capitals on the Kanban diagram</td>
</tr>
<tr>
<td></td>
<td>- Stereotype - displays the element stereotype</td>
</tr>
<tr>
<td></td>
<td>- Phase - displays the element phase</td>
</tr>
<tr>
<td></td>
<td>- Author - displays the name of the element's author</td>
</tr>
<tr>
<td></td>
<td>- Truncate name - cuts off the element name as it approaches the element border, instead of allowing it to wrap around</td>
</tr>
<tr>
<td></td>
<td>- Icon - selected by default; deselecting this checkbox hides the Type and Priority icons in the top right corner of the element</td>
</tr>
<tr>
<td></td>
<td>- Checkboxes - when Checklist elements are displayed on the Kanban diagram, show the Checklist checkboxes and items; Checklist Artifacts can be bound to Priority on a Kanban diagram, and this option makes it easy to view any Checklists organized by Priority</td>
</tr>
</tbody>
</table>
The property checkboxes are directly linked to the 'Use Kanban drawing style' option. If you do not select the option, the element on the Kanban diagram has a more basic appearance with no properties shown other than the author and element names.

| Native Element drawing style | Select this option to render the elements on the Kanban diagram in their native, rectangular notation style, displaying any compartments the elements might have. The Resources compartment is particularly useful for Kanban elements, if compartments are to be shown. This compartment lists allocated resources, including those that are 100% complete. Note that the element width is limited by the width of the lane the element is in, so features in compartments might be shown truncated. |

**Notes**

- All elements added to a Kanban diagram initially have the same height and spacing, but the height can change as displayable information is added to an element
- In a Kanban diagram, the normal element appearance option is not operational; only the Kanban appearance options take effect
Kanban Diagram Options - Advanced

If you do not want to manually add elements to a Kanban diagram, you can use the 'Advanced' page to set up either Package searches or SQL searches to automatically fill the diagram. It is not possible to use both a Package search and a custom SQL search at the same time; if both are specified, the Package search is ignored.

The dialog automatically opens at the 'Package' tab. If you want to create a SQL Search, click on the 'Custom SQL' tab.

Access

| Ribbon | Construct > Task Management > Kanban > (options to generate and/or open a Kanban diagram)  
|        | Start > Collaborate > My Kanban (displays personal default Kanban diagram)  
|        | Then  
|        | Design > Diagram > Edit > Kanban > Advanced (on an open Kanban diagram)  
| Context Menu | On a Kanban diagram, double-click on a lane > Advanced  
|             | On any other type of diagram, right-click on background | Kanban > Advanced  

Kanban Options - Advanced
To fill a diagram based on a Package, simply click on the Add button and on the 'Add Package' option, then select the required Package or Packages from the 'Select a Package' browser.

If you want to include elements from child Packages, select the 'Include Child Packages' checkbox against each Package in the list. Click on the Run Search button. This will automatically add elements, based on the search. The search is additive and will only add elements not currently on the diagram; it will not remove elements that no longer match the search. You can refine the Package search by creating it on the 'Filters' page and adding filters (see the Kanban Diagram Options - Filters Help topic).

To fill the diagram from the results of a custom SQL search, click on the 'Custom SQL' tab and type or paste the appropriate SQL. In order for the diagram to be filled, you must include in the SQL Select statement:

Object_ID as Element_ID

For example:

Select Object_ID as Element_ID From t_object Where Object_Type = 'Requirement'

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
</table>
| Run Search                  | When you have set up either a Package search or a custom SQL search, click on the Run Search button to fill the diagram. All elements found by the SQL search are added to the diagram.  
If you have not applied a filter to a Package Search, all elements from the selected Packages are added to the diagram. If you have used a filter, only those elements that meet the filter criteria are added.  
A 'Progress' dialog displays during the search. If the search is taking a long time or is finding too many elements, click on the Cancel button; any objects already added to the diagram are removed. |
| Add                         | On the 'Package' tab, if you are using a search or filter (from the 'Filters' page of the dialog) you must define a Package or Packages for the search or filter to work on.  
You do this by clicking the Add button and choosing either 'Add Package' to browse to a selected Package, or 'Search Model' to search or filter from all elements in the current model. |
| Remove                      | If you want to clear a Package from the list (or the whole-model selection) click on the item line and click on this button. |
| Include Child Packages       | If you have selected a Package with a child structure, select this checkbox to also include the elements from the structure in the Kanban diagram, or clear the checkbox to include elements from the selected Package only. |
Kanban Diagram Options - Filters

The 'Filters' page can be used in conjunction with the Package search defined on the 'Advanced' page, should you want to apply additional filtering.

It is possible to import a Model Search that has already been created, or to create new filters here exactly as you would for any other Model Search.

When adding any of these searches or filters, you must also select at least one Package for the search or filter to work in; you do this on the 'Advanced' page of this 'Kanban' dialog.

Access

| Ribbon | Construct > Task Management > Kanban > (options to generate and/or open a Kanban diagram)  
|        | Start > Collaborate > My Kanban (displays personal default Kanban diagram)  
|        | Then  
|        | Design > Diagram > Edit > Kanban > Filters (on an open Kanban diagram)  
| Context Menu | On a Kanban diagram, double-click on a lane > Filters  
|             | On any other type of diagram, right-click on background | Kanban > Filters |
## Filter Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Import Search</strong></td>
<td>Click on this button to import a search from either an external XML file ('From File') or from the current model ('From EA').</td>
</tr>
<tr>
<td><strong>Add Filter</strong></td>
<td>Click on this button to define the properties of elements that you want to be added automatically to your Kanban diagram.</td>
</tr>
<tr>
<td></td>
<td>- Note that not all element types will be added to Kanban diagrams; the list of excluded types includes Constraint, Note, Port, ProvidedInterface, RequiredInterface, Boundary, Hyperlink, StateNode, Text, GUIElement, Package, UMLDiagram, InterruptibleActivityRegion and ExpansionRegion</td>
</tr>
<tr>
<td><strong>Edit Filter</strong></td>
<td>Click on this button to edit the currently selected filter in the list.</td>
</tr>
<tr>
<td><strong>Optional / Required</strong></td>
<td>Choose 'Optional' if the filters will be applied with a logical OR relationship. Choose 'Required' if the filters will be applied with a logical AND relationship.</td>
</tr>
<tr>
<td><strong>Remove Filter</strong></td>
<td>Click on this button to delete the currently selected filter from the list.</td>
</tr>
</tbody>
</table>
Default Kanban Diagrams

A default Kanban diagram can be set for the entire repository, and each individual user can also set their own default Kanban diagram; in both cases there are specific options to locate and open the diagrams. These defaults help you to quickly and easily get access to a Kanban board and immediately start contributing to work items that will deliver value to the customer.

To track your own work, you can select:

- The 'Start > Collaborate > My Kanban' ribbon option, or
- The 'Construct > Task Management > Kanban > Open My Kanban' ribbon option, or
- The 'User Default Kanban' menu option from the diagram Caption Bar

To track the team's work, you can select:

- The 'Construct > Task Management > Kanban > Open Project Kanban' option or
- The 'Model Default Kanban' menu option from the diagram Caption Bar

Set the Model Default Kanban

A default model Kanban diagram can help you to visually track a range of work items and their current stage of development through an initiative. This feature ensures that all team members can visualize the important work items in a consistent way and allows them to track the work items as they move from an idea in the backlog through to completion ultimately delivering business value to the customer.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ensure the preferred Kanban diagram is open in the main view.</td>
</tr>
<tr>
<td>2</td>
<td>Select the 'Configure &gt; Security &gt; Administer &gt; User Settings &gt; Set User Default Kanban' ribbon option.</td>
</tr>
</tbody>
</table>

Set My Default Kanban

In a shared security-enabled model environment it is possible to set a user-specific default Kanban diagram. A personalized Kanban diagram can help each member of a team to visually keep track of a range of elements of particular relevance to them, and their current stage of development.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>1</td>
<td>Ensure your preferred Kanban diagram is open in the main view.</td>
</tr>
<tr>
<td>2</td>
<td>Select the ‘Configure &gt; Security &gt; Administer &gt; User Settings &gt; Set User Default Kanban’ ribbon option.</td>
</tr>
</tbody>
</table>

**Notes**

- The model must have user security enabled in order to define a user default Kanban diagram.
### Allocating Resources to Work Items

Enterprise Architect not only helps you to define the work items for a Kanban diagram or workflow but also acts as a sophisticated platform for the allocation and management of resources and the flow of items through the board. This functionality uses both Kanban diagrams and the Resource Allocation features.

Resources are the people who work on a project; they can be assigned roles and allocated tasks, and these roles and tasks can be visualized on a Kanban diagram.

This example shows a number of Kanban work items, one with three resources allocated to it. The tasks performed by the resources are at varying stages of completion, represented by the green progress bars that show the percentage of the work completed.

When a resource allocation is set to 100% complete, it will no longer be displayed in the Kanban object. When all tasks have been set to 100%, it might be time to move the task to the next Kanban lane, changing its status so that the next resources can be allocated. In this example, that might be resources with a 'Review' or 'Testing' role.

### Resource Allocation

To allocate a resource to a Kanban object, you must first open the Resource Allocation window ('Construct > Task Management > Resources'). You then select the object on the Kanban diagram or in the Project Browser and click on the 'New' icon in the Resource Allocation window. Add these details as necessary:

- Resource
- Role or Task
- Start Date
- End Date
- Complete %
- Expected Time
- Allocated Time
• Time Expended
• Description
• History

Click on the Save icon to create the resource allocation - a progress indicator will instantly appear on the work item in the Kanban diagram. This is an important visual cue to show that a resource has been assigned to work on this task or has chosen it themselves. Other team members will immediately be able to see the allocation on the Kanban diagram and make decisions about what work items they will work on. Therefore, it is important not to allocate resources too early as this could slow down the workflow.

The resource allocations for the Kanban Work Item in the previous diagram are shown in this example:

![Resource Allocation Table]

### Completed Tasks

Once you have completed a task, you set its 'Complete %' value to 100. This has the effect of preventing the task's progress bar from being drawn in the object in the Kanban diagram. As well as setting the completion percentage on the task, you might also want to fill in other information, such as the end date and time expended. It might also be time to move the object into the next Kanban lane.

### Resource Tracking

The Kanban features in Enterprise Architect can be used with any project management method. How the features are used will depend largely on what works best for individual teams; the teams might be self organizing without any formal project management controls and other teams might work with a more formal structure. Either way Enterprise Architect provides a number of facilities that will assist with visualizing resources and their allocations to work items.

Enterprise Architect provides searches to allow you to track resources. You can get a list of tasks that each resource is working on, overdue tasks, recently completed tasks, summaries, and more. A team or individual can also write their own custom searches to retrieve any required information from the repository.

### Access

| Ribbon | Construct > Task Management > Active Tasks  
|        | Construct > Task Management > Completed Tasks  
|        | Construct > Task Management > Summary |
# Resource Tracking Searches

<table>
<thead>
<tr>
<th>Search</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Tasks</td>
<td>Searches the project for elements with assigned resources, where the end date is in the future and the percentage completion is less than 100. The output lists all elements with currently active tasks, and shows the details of the resource allocation to each task.</td>
</tr>
<tr>
<td>Tasks Ending Today</td>
<td>Searches the project for elements with assigned resources, where the task end date is today. The output lists all elements with tasks ending today, whether the task is complete or not, and shows the details of the resource allocation to each task.</td>
</tr>
<tr>
<td>Tasks Starting Today</td>
<td>Searches the project for elements with assigned resources, where the task start date is today. The output lists all elements with tasks starting today, and shows the details of the resource allocation to each task.</td>
</tr>
<tr>
<td>Overdue Tasks</td>
<td>Searches the project for elements with assigned resources, where the end date is in the past and the percentage completion is less than 100. The output lists all elements with overdue tasks, and shows the details of the resource allocation to each task.</td>
</tr>
<tr>
<td>Recently Completed</td>
<td>Searches the project for elements with assigned resources, where the end date is in the recent past and the percentage completion is 100. In the 'Search Term' field, specify the number of days over which to check back. The output lists all elements with tasks completed within the specified period, and shows the details of the resource allocation to that task. The output does not include tasks that have already been finished in advance of a future completion date.</td>
</tr>
<tr>
<td>All Completed</td>
<td>Searches the project for elements with assigned resources, where the percentage completion is 100.</td>
</tr>
</tbody>
</table>
The output lists all elements with completed tasks, and shows the details of the resource allocation to each task.

| 30 Day Task Summary (Brief) | Provides a brief summary of the tasks performed by resources over the previous month. The output groups tasks with similar project role and calculates for each resource: the count, the sum of expected time, and the sum of expended time for all tasks that have started in the last 30 days. To look at or change the master list of project roles that this search uses for grouping tasks, select 'Configure > Reference Data > Project Types > People > Project Roles'. Grouping by similar project role means that, for example, 'Review 1' and 'Review 2' would be grouped together under 'Review' if and only if the current project's list of project roles includes one called 'Review'. |
| 30 Day Task Summary (Full) | Provides a full summary of the tasks performed by resources over the previous month. The output groups tasks by project role and resource, and lists the count, sum of expected time, and sum of expended time for all tasks that have started in the last 30 days. |
| 30 Day Resources | Searches the project for tasks that have started in the last 30 days where the resource name matches (fully or partially) the text in the <Search Term>. |
| 30 Day Roles | Searches the project for tasks that have started in the last 30 days where the role name matches (fully or partially) the text in the <Search Term>. |

Charts and Dashboards

Enterprise Architect has a sophisticated charting facility that allows a wide range of charts to be created, through which you can visualize and analyze repository information. This is particularly useful with Kanban diagrams and resource allocations, and provides an alternative view of the Kanban cards, allowing a Product Owner, Project Manager or other team member to get a visual image of things such as the Number of Active Tasks by developer, the Phases the Work Items are in by developer, the Number of Work Items at each stage of a Kanban Board and much more. The charts can provide powerful information that will help improve the teams performance and ultimately result in high value product or service features being available to customers in the shortest possible time frame. Any number of charts can be created from built-in Patterns, but a team is also free to create user defined charts, dashboards and reports.

Example - Active Work Items by Team Member

This bar chart shows the number of active tasks by team member. The names of the team members are listed on the vertical axis and the Number of Tasks on the horizontal axis. A small numerical value indicates the number of active tasks allocated to each team member.
Example - Completed Work Items by Team Member

This compelling bar chart shows the number of work items completed by the members of a team in a particular phase of the process. The team members are represented on the vertical axis and the number of completed work items on the horizontal axis. Color has been used to help visualize the work items completed in a given phase; a Diagram Legend lists the relationship between color and phase. A small numeric indicator indicates the number of items completed in each phase for each team member.
Example - Weekly Work Item Summary by Phase

This expressive bar chart provides a weekly summary of the number of Work Items completed by phase. The Phases are represented on the vertical axis and the Number of Work Items on the horizontal axis. The chart can provide powerful information that will help improve the teams performance.
Related Model Elements

There is a wide range of tools that allow teams to create Kanban diagrams, but Enterprise Architect stands on its own as a tool that not only allows a team to use the powerful Kanban features but is also a sophisticated platform for managing the work products of every discipline working on Enterprise, Business or Technology initiatives. This means that instead of having to access other tools or out-of-date documentation or schedule meetings the information related to a work item is immediately available inside the same repository. An analyst, developer, tester or other team member working on a User Story, Feature, or Defect can locate the related Requirements, Business Rules Policies, Standard Operating Procedures, Strategies, Drivers, Goals, Stakeholders Requirements, Architectural designs, Principles, Programming Code, Database and Information Schemas, XML definitions, Messages, Test Cases, Applications, Deployment Targets and Specifications and more.

Relating Model Elements

Enterprise Architect allows a user to create any number of connections between model elements, using the connectors that form part of the chosen modeling language. Any item that appears in a Kanban diagram can be dragged onto any other diagram and then connections can be added. For example, a User Story that is coming to the top of a backlog or is in a Queue lane in a Kanban diagram could be added to a Business or Stakeholder Requirements diagram, and Trace relationships could be added between the User Story and the Requirements, indicating which requirements relate to the Story.
Finding Related Model Elements

The work items in a Kanban board can be related to any other elements in the model, allowing a powerful and expressive graph to be defined. While it is possible to add your own connections, quite typically other team members working in related disciplines and parts of the repository will have already added relationships to other model elements, which in turn will be related to still other elements and so on.

These connections can all be visualized in existing diagrams, but a modeler can create a new diagram and place the work item in the center of the diagram, choosing the Insert Related Elements feature to insert the graph of related elements that can be configured to draw an expressive diagram reaching out to the very corners of the repository.

This diagram shows the result of using the Insert Related Elements feature to find the important information needed when working on a User Story.

As A Student I want to buy books at Academic Prices
Requirement «UserStory»
Version: 1.0 Phase: In Progress
Priority: High

Student Verification
«column»
ID: NUMBER(8,2)
INSTITUTION NAME: NVARCHAR(50)
YEAR: NUMBER(4,2)
STUDENT NUMBER: VARCHAR2(20)

Rules Analyzer
This is a customer built rules engine used to manage configuration items. It has been extended to allow rules to be viewed and updated through a business web interface.

«business rule»
Any person studying who is under the age of 27 with student identification is considered a student
(from Business Rules)

«policy»
The bookstore will provide discounts to students to encourage learning
(from Policies)

«goal»
Provide customers with a competitive online shopping experience
(from Goals)

REQ117 - The system must provide a mechanism allowing students to identify themselves
As A Student I want to buy books at Academic Prices
This Requirements diagram shows a User Story that has been added to a Kanban diagram expressing the relationships to a number of business and technical elements.

(c) Sparx Systems 2018
Page 42 of 56
Created with Enterprise Architect
Managing a Backlog

The Backlog (or Product Backlog, as it is called by some Agile methods such as Scrum) is an ordered list of items that will deliver business value to the customer. It can consist of a heterogeneous list of item types ranging from Features, User Stories and Requirements (including Non-functional Requirements) to Defects, Changes and more. In fact, in Enterprise Architect any element can be placed onto a Backlog; the ones that are listed and those that appear in the Toolbox are simply the most common. The Backlog is an ordered list based on the business value, with the higher value items percolating to the top of the list. The list is owned and managed by the Product Owner or their equivalent; that is, someone acting as a surrogate for the customer.

Ordering Items in a Backlog Lane

When working with a one-stage workflow, the Backlog items will typically be contained in the first lane of the Kanban and can be dragged to a new location in the lane to change the order of items in the backlog.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select the Item to be moved in the Backlog diagram.</td>
</tr>
<tr>
<td>2</td>
<td>Drag-and-drop it into a new location in the backlog lane.</td>
</tr>
</tbody>
</table>

Prioritizing a Backlog

The order of the items in the Backlog typically is carefully and thoughtfully determined by the Product Owner and reflects the business value - the items promising high business value are located at the top. The prioritization of the Backlog is the Product Owner's responsibility, but it is not decided in isolation from other team members and the Product Owner relies on access to important information from a range of stakeholders, from senior executive level stakeholders, business and operation managers, requirements and business analysts down to implementation teams.

A range of strategic diagrams and materials provide a source for many of the prioritization decisions. These include: Strategy Maps, Business Drivers, Goals and Objectives, and Roadmap diagrams that describe the time-based sequencing of packages of work. The example Roadmap diagram could be used by the Product Owner as an input to what is of high priority to the Business, or what has been planned by the Enterprise or Business Architecture teams. The diagram will prove useful in discussions with both the business stakeholders and the implementers, who can gain a business context for the work they are completing.
Implementers' and other stakeholders' comments will also provide a valuable source of information and input into the prioritization of the backlog. Enterprise Architect has a Collaborate window, which is a highly collaborative facility through which any team member can enter discussion posts against an element and other users can reply and join the discussion. This can create a rich and useful tapestry of knowledge that will not only help the Product Owner in deciding the item's position in the backlog list but will also assist implementers when they are ready to implement the item.

Another critical piece of information that will help the Product Owner is the item estimates completed by implementers, who make their best estimation of how long the item is likely to take. Agile teams using User Stories tend to use Story Points, but any unit of measure can be used as long as the team agrees upon a standard. Some teams will use actual times based on units such as number of hours, whilst others will use effort-based estimates. Enterprise Architect has a flexible and integrated resource allocation facility where team members can add estimates, allowed time, actual times, completion percentages and more. This will be invaluable for the Product Owner, who might have a broad idea of the
time required to complete an item but who relies heavily on the details supplied by the team. The time estimate can be entered in the 'Expected Time' field of the Resource Allocation window.

Example

This diagram shows how a backlog can be defined in a one-stage workflow, allowing items to be dragged and dropped in a single column to define the order of the items in the backlog.

Ordering Items in a Backlog Diagram

When working with two or three stage workflows the Backlog items are contained in a Kanban board representing the entire Backlog, allowing them to be moved between lanes from low to medium, high or critical or using any user defined...
lane names or bound property.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ensure the Backlog Kanban diagram is open.</td>
</tr>
<tr>
<td>2</td>
<td>Select the work item to be prioritized in the diagram.</td>
</tr>
<tr>
<td>3</td>
<td>Drag and drop the item into a new location, either in the containing lane or in another lane.</td>
</tr>
</tbody>
</table>

### Securing a Backlog

The Backlog is a communication tool that insulates the implementers from the need to decide what they should be working on. It is owned and managed by the Product Owner, who ultimately decides what should be on the Backlog and the order of the items it contains. It therefore must be secured from inadvertent changes. The implementation team should have access to the Backlog, but for the purposes of pulling items from a work queue to the In-Progress lane, which could be continuous flow-based (Kanban) or time-boxed (such as a Sprint). The development team also need to provide time estimates for the items in the Backlog, which will help the Product Owner decide upon the order of items, particularly when two or more items have comparable business value. The item with the lowest completion estimate will typically be given a higher position. Developers are also expected and encouraged to comment on the items in the Backlog so that the Product Owner can understand any issues or have access to learning from prior initiatives or insights.

Enterprise Architect’s security system can be used to lock the Backlog while still allowing people to make the necessary contributions of time estimates and comments in the form of discussions.

With the Security System enabled and either a group for Product Owners or individual users who are Product Owners added, a Backlog diagram can be locked by the individual Product Owner user or a member of the Product Owner group. This example shows the Backlog being locked by the Product Owner group, but for a repository that is accessed by a number of Product Owners it could be more expedient to lock the diagram to an individual.

When the Backlog diagram has been locked by the Product Owner, other team members will be able to view the diagram but a small red marker to the left of the diagram name in the Project Browser will indicate that it is locked. The Project Manager will see a blue marker indicating that they have access to edit the diagram.
Securing a Backlog Diagram

Secure a Backlog diagram, remembering that it can be locked at a user or a group level.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Locate and select the Backlog diagram in the Project Browser.</td>
</tr>
<tr>
<td>2</td>
<td>Right-click on the diagram name and select the 'Lock Diagram' option. The 'Lock Diagram' dialog displays.</td>
</tr>
<tr>
<td>3</td>
<td>Select the 'User Lock' or 'Group Lock' option from the 'Lock Type' list.</td>
</tr>
<tr>
<td>4</td>
<td>Select the User, or the Group from the 'Group ID' drop-down list.</td>
</tr>
<tr>
<td>5</td>
<td>Click on the OK button to save the changes.</td>
</tr>
</tbody>
</table>

Notes

- The model must have user security enabled in order to lock the backlog Kanban diagram
- To secure a Backlog a two or three stage workflow is required where the Backlog is a separate Kanban diagram
Elaboration and Grooming

During the process of prioritizing the backlog and as work items move closer to the top of the Backlog or onto the work Queue they must be prepared for the In-Progress stages of the workflow - in traditional methods this process is termed 'elaboration', but is known as 'grooming' in Agile methods. Enterprise Architect has a number of facilities that can assist with the grooming of work items so that when they are pulled onto an In-Progress lane the right information is available for an implementor to immediately start work.

Enterprise Architect has a form of requirement that is internal to an element and allows supplementary and more specific requirements to be added to a Work Item. These requirements are created in addition to the business, stakeholder, functional and non functional requirements that might exist for the work item.

There is also a wide range of information that can be entered as Change Management Items for a selected Kanban Work Item. These items include Changes, Defects, Issues, Tasks, Events, Decisions, Effort, Risk and Metrics, and add rich additional information that will assist all team members including the Product Owner and the Implementation team.
Enterprise Architect also has an Element Browser that is a convenient tool for viewing all the related information about an element in a single place. The Element Browser can be kept open as a docked window and items can be selected in a Kanban diagram, List, Gantt chart or the Project Browser, and the Work Item's specific information will be displayed.
Alternate Views

Enterprise Architect is a powerful modeling platform that can be used by any number of stakeholders ranging from high level executives to implementation teams, providing a variety of communication devices suitable for each stakeholder group. There are four other views of a Kanban diagram that will be appealing to many stakeholders, particularly project managers, schedulers, development managers and product owners; these can be viewed by simply toggling from view to view:

- **Gantt View**
  This view provides a visualization of the work items and the assigned resources in a Gantt Chart, which is particularly useful for people who might be more familiar with this more traditional representation or who want to get an overview of the schedule of tasks.

- **List View**
  This view is a spreadsheet representation, where the work items are the rows and the properties and Tagged Values are the columns.

- **Specification Manager View**
  This view lists the work items with the contents of each element's Notes field.

- **Traceability Window**
  This view helps a team member to quickly review dependencies and other relationships between work items to any depth, and to locate the items in other diagrams.

Switching between Views

A Kanban diagram, like all diagrams, can be switched to an alternative view and, once in this view, can be switched to any other view without affecting the underlying layout of the diagram.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ensure the diagram is the active tab or has focus.</td>
</tr>
<tr>
<td>2</td>
<td>Ribbon: Design &gt; Diagram &gt; View As &gt; Graphical / List / Gantt / Specification</td>
</tr>
</tbody>
</table>

List View

The List View provides a spreadsheet-like visualization of the work items and their properties and Tagged Values. It allows properties to be viewed and compared across the entire corpus of work items that make up the diagram and allows...
properties such as status to be edited inline using drop-down lists of values where they apply. It also has a clever mechanism that allows the list to be grouped by property down to any number of levels and a filter that is useful when wanting to restrict the view of work items with a particular property or name - for example, all work items relating to the Warehouse Manager.

Access

### Ribbon

Design > Diagram > View As > List

### Context Menu

Right-click on diagram background | Open Diagram in | List View

### Gantt View

The Gantt View provides a traditional Gantt Chart in the form of bar chart representing the scheduling of the work items including: their start and finish times and the percentage complete. It is a graph that provides a time oriented view of the work items and is useful for project managers and project schedulers or other team members who want to view all the work items in a single view.
Access

<table>
<thead>
<tr>
<th>Ribbon</th>
<th>Design &gt; Diagram &gt; View As &gt; Gantt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Context Menu</td>
<td>Right-click on diagram background</td>
</tr>
</tbody>
</table>

Specification Manager View

The Specification Manager is a simple document-based interface to a selected diagram (or Package) in the model, providing the means of creating and reviewing elements as text representations of objects in the model, using a process that is familiar to all users including business professionals and management, who might not have expertise in model development.

The Specification Manager is also an interactive reporting tool for displaying, in icon form, the status of various other features against each entry and providing access to edit each feature.

Access

<table>
<thead>
<tr>
<th>Ribbon</th>
<th>Design &gt; Diagram &gt; View As &gt; Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Context Menu</td>
<td>Right-click on diagram background</td>
</tr>
</tbody>
</table>

Traceability View

The Traceability Window provides an insightful view of how a work item is connected to other elements in the model including other work items and how these connected elements are themselves connected down to any level. It is a general purpose mechanism and so can be used with any type of element but is particularly useful when working with Kanban boards and for product owners and other team members who need to understand the dependencies between work items and to find the related information that will help with the analysis, grooming, testing and implementation of a work item.
Access

Ensure a Work Item is selected in a diagram or other view.

| Ribbon      | Design > Impact > Traceability |
Other Processes and Methods

Kanban is not a process in traditional classification but more of a way of visualizing work items, and a method for creating efficiencies and ensuring customer value is delivered as soon as possible. Kanban can be used in isolation or in combination with any existing processes, including Scrum, Iterative and Incremental and Waterfall Processes. Each of these processes has their place and can be used with Kanban even though much of the literature about process is currently focused on iterative families of processes such as Agile.

The compelling thing about Kanban is that it provides a visualization of the flow of Work Items from the ideas stage through to delivering demonstrable value to the customer transparently to every team member.

Scrubban

Scrubban is a hybrid methodology combing aspects of Scrum and Kanban. Scrum teams can typically work with the same process they have always used, including Sprints, Standups, Retrospectives and Demos, but incorporate Kanban as a way of visualizing the Work Items, allowing just-in-time planning and benefiting from being able to set Work-In-Progress (WIP) Limits. The work items that have been selected for the Sprint or Iteration can be pulled from a Backlog Kanban board onto the Queue lane of an Iteration Kanban board.

Using Scrubban overcomes limitations or issues that some Scrum teams experience such as: excessive time required in Sprint planning, a loss of focus due to implementers working concurrently on too many User Stories, Defects or other items and information being forgotten over the period of the Sprint. The built-in one, two or three stage workflows would all be suitable for Scrubban but a team is free to define their own workflow, create their own Kanban boards and define their own lanes and sub-lanes.

Iterative Methods

Iterative and incremental methods have been in use since the mid nineteen seventies and have been incorporated into a number of waterfall processes as well as being used in isolation. These processes can all benefit from the use of Kanban diagrams as a way of visualizing the work items in an iteration and any number of Kanban diagrams can be created to manage concurrent iterations.
Waterfall

Waterfall or modified methods have been in use since the mid nineteen-seventies and have been baked into a number of standards, particularly in industries such as the military, aviation, travel and finance, where outcomes typically need to be determined in advance of a development cycle. Waterfall methods are often used when requirements are locked down and scope is determined in advance, the product is stable and the technology platforms are well known and understood. These processes can all benefit from the use of Kanban diagrams as a way of visualizing the work items as they flow from phase to phase.